
What is Second Life? 
Second Life is an online 3D virtual 
world. While Second Life has the look 
and feel of a video game, it is not a 
game. There are no winners or losers, 
nor points to obtain or levels to 
achieve in Second Life. Instead, 
Second Life is a loosely structured 
online community where residents are 
free to communicate and interact with 
each other with few restrictions. 

Second Life runs on servers owned by 
a company called Linden Lab that is 
based in San Francisco, California. 
Linden Lab also develops and 
maintains the software that makes 
Second Life possible. While Linden 
Lab owns the Second Life platform, 
the objects created in Second Life are 
owned by its residents. This has 
made it possible for the virtual world to 
develop its own in-world economy 
where objects are bought and sold. 
Second Life even has its own 
currency, the Linden dollar, which can 
used to buy and sell the objects 
created within the world. Linden 
dollars can be acquired in-world or 
they can be purchased with real world 
currency. 

The Second Life world is divided into 
several areas that consist of inter-
linked regions made up of virtual land, 
water and sky. Each region can 
support 15,000 prims, which are the 
basic 3D geometrical shapes that 
make up the virtual objects in Second 
Life (such as buildings, trees, etc). 
Using Linden Scripting Language 
(LSL) these objects can be animated 
and made interactive, bringing them to 
life in the virtual world. However, you 

do not have to know how to build 
objects from prims to enjoy Second 
Life. Many objects are already 
included in your Library when you 
join and you can also locate many free 
objects made available by other 
residents. 

How do I get started? 
In order to access Second Life, you 
must sign up for an account at the 
Second Life website. There are two 
types of accounts in Second Life: 
basic accounts and premium 
accounts. 

Your first basic account can be 
obtained free of charge. Premium 
accounts and additional basic 
accounts require you to pay a small 
fee. The primary benefit of a premium 
account is that it will allow you to own 
land in Second Life. However, land 
ownership does require that you pay 
land taxes which will vary with the 
amount of land you own. 

To sign up for a new account: 
1. Go to http://secondlife.com and 

click on Get Started! 
2. Click on one of the thumbnails to 

choose the starting look of your 
avatar.

3. Enter your desired Second Life 
name. You have some choice for 
your in-world first name, but you 
must choose your in-world last 
name from a list of pre-existing 
names.

4. Enter a valid email address where 
you can receive an account 
activation link. Your account will 
not be available until you click on 
the link to activate it. 
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5. Enter the required personal 
information, such as your country 
of residence, birthdate, real life first 
and last name, and gender.

6. In the Password section, enter a 
password and select a security 
question. The answer to this 
question will be used to verify your 
identity if you forget your user 
name or password.

7. Scroll down on the page and enter 
the code from the image in the 
reCaptcha field. 

8. Check the box to indicate that you 
agree to the Terms of Service and 
click on Create Account. 

An email with the activation link will be 
sent to the email address you 
provided. Click on the activation link to 
finish setting up your account. 

Once you've signed up for an account, 
you will have to download a client 
program to access Second Life. Client 
programs are available for Windows, 
the Mac and Linux. Before you 
download the client, you should visit 
the system requirements page 
available at:



 http://secondlife.com/support/

 sysreqs.php 

The information on this page will help 
you determine if your computer meets 
the specifications required to run the 
Second Life client. In general, you will 
get the best performance from Second 
Life if you have a fast connection 
(broadband) and a fairly fast graphics 
card. 

Getting Around in Second Life
When you first log into Second Life 
you can go through a brief tutorial in 

Orientation Island to help you become 
familiar with the controls needed to 
move around in the virtual world: 
• Up arrow: moves your 

avatar forward.
• Down arrow: moves 

your avatar back.
• Right arrow: turns your avatar to the 

right.
• Left arrow: turns your avatar to the 

left.
• Shift + Right arrow: moves your 

avatar right.
• Shift + Left arrow: moves your 

avatar left.
• Page Up: makes your avatar 

jump.
• Page Down: makes your 

avatar crouch down.
 
You are not limited to keyboard 
commands for moving in Second Life. 
You can also turn on the Movement 
Controls in the View menu. These 
controls are shown below:

Another way to move around in 
Second Life is by turning on Fly Mode. 
This allows you to use the arrow keys 
on your keyboard to fly around in the 
virtual word. To turn on Fly mode, click 
the Home key on your keyboard (or 
hold down the Page Up key until your 
avatar is flying). Once you are in Fly 
mode, you can go up and down by 
using the Page Up and Page Down 
keys. The arrow keys work the same 
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way in Fly mode as when youʼre 
on the ground. To exit Fly 
mode, click on the Home key 
once again. If you do this while youʼre 
just a few feet off the ground, your 
avatar will land safely on his or her 
feet. If you do it while youʼre flying 
higher up, your avatar will have a 
much rougher landing, but this will not 
cause any damage to him or her.

Mouselook
The default view in Second Life is to 
have the camera slightly behind and 
on top of your avatar. In this view, the 
cameraʼs focus is indicated by the 
white dot in front of your avatar. If you 
left-click on your avatar and drag with 
the mouse, you will change the 
cameraʼs focus and the direction your 
avatar is facing at the same time. 

If you donʼt like the default view, you 
can switch the view so that you are in 
first person mode, looking through 
your avatarʼs eyes. This is known as 
Mouselook. To turn on Mouselook, 
select View > Mouselook or press the 
M key on your keyboard. You will see 
a small square pointer in the middle of 
the screen. You can use the mouse to 
turn in any direction and to look up 
and down, and the arrow keys to 
move forward/back and side to side. 
Note that the menus are not available 
in Mouselook. To exit Mouselook and 
bring back the menus, press the 
Escape key on your keyboard.

Another way to enter and exit 
Mouselook is by using the scroll wheel 
on a mouse. To enter Mouselook with 
the scroll wheel, scroll up until you 
zoom past your avatarʼs head and the 
pointer changes to a small square. To 
exit Mouselook, scroll back out until 

you see your avatar. Using Mouselook 
can be helpful when you are in Fly 
mode, as you can quickly move in any 
direction by aiming the pointer and 
pressing the Up Arrow to move 
forward. 

Using the Camera
When you are in the default third 
person view, you can click on your 
avatar and drag with the mouse to 
have your avatar and the camera look 
in the same direction. The camera 
controls can help you get a better view 
of the objects in the virtual world. 
These controls are shown below:

Move Camera 
Left/Right

Zoom In/OutOrbit Camera 

If you would rather use the keyboard 
shortcuts, they are as follows (Mac 
users should use Command instead of 
Control and Option instead of Alt):
• Alt-click: sets the focus for the 

camera (the point around which it 
will move/rotate).

• Alt-click and move the mouse left/
right (or Alt-click and use the left/
right arrow keys): moves the camera 
left and right.

• Alt-click and move the mouse 
forward/back (or Alt-click and use 
the up/down arrow keys): zooms in/
out.

• Alt+Page Up/Page Down: moves the 
camera up/down

• Alt+Control-click: orbits the camera 
around the camera focus point.
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• Double-click on avatar: resets the 
camera.

You can also zoom in and out without 
turning on the camera controls by 
using Control + 0 to zoom in and 
Control +8 to zoom out. Control + 9 
resets the zoom. 

To reset your view, choose View > 
Reset View or press the Escape key 
on your keyboard.

Teleporting and Landmarks
While you can explore a lot of the 
Second Life world just by walking and 
flying around, when you need to get to 
another island in the virtual world fast 
teleporting is the best option. To 
teleport to another location:
1. Click on the Search button at the 

bottom of the Second Life window. 
2. Click on the Places tab at the top 

at the top of the Search window. 
3. Enter a search term in the Find 

text field and click on Search. You 
will see a list of places matching 
your search criteria on the left side 
of the Search window. On the right, 
you will see a preview of the 
currently selected place, a brief 
description of what you will find 
there, and its Second Life location 
information. 

4. To teleport to the selected place, 
click on the Teleport button. After a 
few seconds you will find yourself 
in the new location. 

In addition to places, you can use the 
Search feature to find people, events 
and groups. 

As you explore the virtual world of 
Second Life, you may want to save 
landmarks (the equivalent of favorites 

or bookmarks in your web browser) so 
you can return to your favorite 
locations.

To create a landmark, select World > 
Create Landmark here. This will add 
the landmark to your Inventory in a 
Landmarks folder. To go back to a 
location in Second Life using a 
landmark, open your Inventory by 
clicking on the Inventory button in the 
lower right corner of the screen (or 
use the keyboard shortcut Command/
Control + I), then find the landmarks 
folder (under My Inventory) and 
double-click on a landmark. You will 
be prompted to confirm that you want 
to teleport to the location in the 
landmark. Once you click on Teleport 
you will be immediately taken to the 
location you saved as a landmark.

The Maps
If you get disoriented while navigating 
the virtual world, you can use the 
world map and the mini-map to get 
your bearings. The world map can 
also be used to teleport to a different 
location in the virtual world. 

To teleport to another location using 
the world map:
1. Click on the Map button in the 

toolbar (or press Command/
Control + M) to open the world 
map. You can zoom in and out on 
the world map by using the scroll 
wheel on your mouse. In the upper 
left corner of the screen you will 
see a legend showing what each 
symbol on the map represents. 
Your location on the map will be 
indicated by a white circle inside a 
yellow circle. 
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If you donʼt see this symbol on the 
map, click on Show My Location 
on the right side of the window to 
center the map on your current 
location. The location of other 
residents (avatars) will be 
indicated by green circles on the 
map.

2. Click on the location you wish to 
visit by clicking once on the map. 
This location will be marked with a 
red circle.

3. Click on the Teleport button on the 
right. After a few seconds you will 
be taken to the location you 
selected on the world map.

You can also use the map to teleport 
to a location you have saved as a 
landmark. To do this, select the 
landmark using the My Landmarks 
pulldown menu on the right side of the 
map window (below the map legend), 
then click on the Teleport button. 

The Mini-Map provides a more 
localized view of your immediate 
surroundings. In the mini-map you can 
see the outlines of the structures 
around you. 

As on the world map, the location of 
other avatars is indicated by green 
dots. To open the Mini-map, click on 
the Mini-Map button in the toolbar or 
press Shift + Command/Control + M.

Going Home
You can set any location in the virtual 
world as your home by selecting 
World > Set Home to Here. To go 
back to your home location from 
another location in the virtual world, 
choose World > Teleport Home or 
press Shift + Command/Control + H. 
While viewing the world map, you can 
quickly teleport home by clicking on 
the Go Home button in the upper right 
corner of the screen (next to the map 
legend). 

Chat and Instant Messaging
The Second Life client includes chat 
and instant messaging (IM) to allow 
you to communicate with the people 
you meet in the virtual world. The 
ability to effectively use these 
communication tools is an important 
skill to master as it will help you build 
meaningful relationships with other 
users and become an active 
community member in Second Life.

Chat is a public form of 
communication in Second Life. Chat 
messages can be seen by anyone 
within 20 meters of you in the virtual 
world. To begin a chat, click on 
the Chat button in the toolbar 
at the bottom of the screen. This will 
display the Chat bar where you can 
enter your message. As you type your 
message into the Chat bar your avatar 
will appear to be typing (you should 
also hear a typing sound if you have 
your sound turned on). When you 
press Enter or Return to finish your 
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message, it will appear above the 
Chat bar in a semi-transparent box.
You can shout a message so it is 
viewable over a larger area around 
you (100 meters). To shout a 
message, type your message in the 
Chat bar, click the up 
arrow on the Say button 
and select Shout. This 
will allow your message 
to be seen by more 
people around you, but it is 
considered rude and should be 
avoided.

When there are too many people in 
the same area, it may be difficult to 
keep track of a conversation. If you 
think youʼve missed something 
someone has said, you can always 
view a transcript of the local chat by 
selecting View > Local Chat. 

Instant Messaging (IM) allows for 
private communication in Second Life. 
Only the person you send the IM to 
can see it. To send an IM to someone 
near you, right-click on their avatar 
(Command-click on the Mac) and 
select Send IM from the pie menu. 

This will open an IM window where 
you can type your IM message. When 
youʼre ready to send your message, 
click on the Send button or press the 
Enter key (Return on the Mac). The 
other person will see an IM Received 

notification in the lower left corner of 
the screen. He or she can click on this 
notification to see the message youʼve 
sent and to send you a reply. When 
youʼre finished with your IM session, 
click on the X in the upper right corner 
of the IM window to end the session. 

To send an IM to someone who is not 
near you, you must add them as a 
friend (as described in the next 
section) or find them using the Search 
feature. To find another user in 
Second Life, click on the Search 
button and enter the other personʼs 
Second Life name in the Find field of 
the People tab. When their name 
shows up in the search results, select 
it and click on the Instant Message 
button on the right. You can send IM 
messages to other users even if they 
are not logged in at the same time as 
you. The message will be received the 
next time they log in.

Friends
You can add someone as a friend so 
that their name appears in your 
Contacts list and it is easier to 
communicate with them. To offer 
friendship to someone near you, right-
click on their avatar (Command-click 
on the Mac) and choose Add Friend. 
The other person will see a prompt 
asking them to either Accept or 
Decline your offer of friendship.

To offer friendship to someone who is 
not near you, you will first have to find 
them using the Search feature. Open 
the Search window by clicking on the 
Search button in the toolbar, then 
enter the name of the person youʼre 
looking for in the Find field of the 
People tab. Once youʼve found the 
user you want to add as a friend, 
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select their name in the search results 
and click on Add Friend on the right.

Once the other person accepts your 
friendship offer, their name will be 
added to your Contacts list. To view 
this list, click on the up arrow on the 
Communicate button and choose 
Contacts. 

To the right of each contact, you will 
see a series of check boxes you can 
use to assign friend permissions. 

For example, you can prevent a user 
from seeing your online status by 
unchecking the box below the eye 
icon. Once youʼve added someone to 
your Contacts list you can use the 
buttons on the right side of the 
Contacts window to send them an IM 
or to Teleport to their location.

Voice Chat
Before you can start a voice chat 
session, you need to make sure it is 
enabled in the Second Life 
preferences. Select Edit > 
Preferences and click on the Voice 
Chat tab on the left. You will see 
several settings you can change:
• Enable voice chat: check this box to 

enable the voice chat feature.
• Hear Voice Chat from camera or 

avatar position: this setting will 
determine whether your sound will 

get softer as you move your avatar 
or the camera away from the sound 
source (another avatar or an object).

• Push to talk in toggle mode: allows 
you to set the Talk button to toggle 
instead of having to hold down the 
trigger while you talk.

• Push to talk trigger: allows you to 
use a key as a trigger for starting a 
voice chat.

• Device settings: this is where you 
select the input and output devices 
as well as set the volume level.

Once youʼve set up voice chat, you 
can start talking with the people 
around you by pressing the Talk 
button (you may have to hold it down 
or toggle it on and off, depending on 
your preferences). When youʼre 
talking the white dot above your 
avatar will have green sound waves 
coming out of it. To enable hands-free 
voice chat, click on the lock icon on 
the left side of the Talk button.

As with text-based chat, you can also 
start a private voice chat with 
someone in your Contacts list. To start 
a private chat, open the Contacts list 
and select the name of the contact, 
click on the IM/Call button on the right 
side of the Contacts list and click on 
Call. The other person will see a 
prompt where they can either accept 
or decline your invitation. Once a 
connection is established, you can 
press the Talk button to talk to only the 
person on the call. When youʼre 
finished, click on End Call to hang up 
and end the session. 

Gestures
Your body movements are also an 
important component of 
communication in the virtual world. 
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Gestures allow you to control how 
your avatar moves. To activate a 
gesture, click on the Gestures button 
in the Chat bar and select a gesture 
from the menu.

Once you know a few gestures you 
can activate them during a chat by 
entering the backslash character (/) 
followed by the name of the gesture. 

To add more gestures to your avatar, 
open up your Inventory (click on the 
Inventory button in the toolbar or 
press Command/Control +I). Next, 
look for the Gestures folder in the 
Library section, choose the Gesture 
you want to add, and drag it onto your 
avatar. The gestures youʼve added will 
then appear in the Gestures menu. 

Postcards
Postcards allow you to send a picture 
of any location you visit in Second Life 
to another user, along with a link to 
that location. Postcards can be sent to 
any valid email address, even if the 
recipient does not have a Second Life 
account. To send a postcard, click on 
the Snapshot button in the toolbar to 
take a snapshot of the screen, then 
make sure the Send via email radio 
button is selected. Next, click on the 
More button and set your image size 
and quality options and click on the 
Send button. This will open another 
window where you can address your 
postcard and enter the message you 
want to send along with the snapshot. 
When youʼre finished drafting your 
message, click on Send. 

Second Life URLs
The website for the SLURL builder 
provides an easy way to share links to 
exact locations in Second Life. You 

will need to know two things to build a 
Second Life URL: the correct name of 
the region you want to link to (spacing 
and case sensitivity are important) 
and its X, Y and Z coordinates. This 
information appears in the menu bar 
at the top of the window.

Once you have the required 
information go to http://slurl.com and 
click on the “Build your own SLurls” 
link. Next, enter the region name and 
the coordinates in the appropriate text 
fields and click on Generate SLurl. 
The SLurl will appear in the Your SLurl 
field . You can copy this URL and 
paste it into an email or post it on your 
website.

Modifying Your Avatarʼs 
Appearance
An avatar is a virtual representation of 
each resident in Second Life. It is also 
the primary way in which residents 
interact with the virtual environment by 
moving around in it and manipulating 
its objects. 

One of the most popular things to do 
in Second Life is to change your 
avatar's appearance to reflect your 
personal preferences. You can make 
your avatar closely match your 
appearance in the real world, or you 
can experiment with a whole new 
persona. 

Your avatarʼs appearance is made up 
of your body shape and other physical 
characteristics, your clothes, and any 
attachments (objects youʼve picked up  
during your exploration of Second 
Life). 
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To edit your avatarʼs appearance, 
right-click on your avatar and choose 
Appearance from the pie menu (or 
select Edit > Appearance). The 
appearance window will open, your 
avatar will turn to face you, and the 
words “Editing Appearance” will 
appear above it. This is to let other 
people know that you are busy editing 
your avatarʼs appearance.

Any changes you make in the 
Appearance window will change your 
avatarʼs appearance almost 
instantaneously (sometimes there is 
some lag depending on your systemʼs 
performance). If you hover over your 
avatar, you will notice that the camera 
has been turned on. You can click and 
drag with the camera to change the 
zoom and move around your avatar 
for a better look.

The Appearance window has a series 
of tabs on the left side for modifying 
your avatarʼs body and clothing. When 
you click on a tab you will see a series 
of sliders and thumbnails on the right 
side. There are three ways to make a 
change using these controls:
• Drag a slider left or right to make 

gradual adjustments.
• Click on a thumbnail to either 

increase or decrease a setting by a 
value of ten.

• Enter a specific value in the text field 
to the right of a slider.

Some of the tabs will have buttons for 
making more specific adjustments to 
your avatar. For example, when you 
click on the Shape tab you should see 
a Body button for changing your 
avatarʼs height, body thickness and 
body fat, as well as buttons for 

modifying each individual body part 
(head, eyes, chin, etc.).

The Randomize button at the bottom 
of each tab has Second Life choose 
random settings for you. Clicking on 
this button will only affect the settings 
for the currently selected tab and 
button. For example, if you have the 
Body button selected in the Shape 
tab, clicking on the Randomize button 
will change your body shape but it will 
not affect your eyes, ears and so on.

Some of the tabs will include boxes for 
adding an image. In the skin tab, 
clicking on these boxes will open a 
separate window where you can 
select an image uploaded to your 
Inventory to use as a tattoo. In the 
Eyes tab, the one box available allows 
you to choose an image to use for 
your avatarʼs pupils.

To change your avatarʼs gender, click 
on the Female or Male radio button in 
the Shape tab of the Appearance 
window. Your body shape and other 
characteristics will change to reflect 
the gender you choose.

If you find you donʼt like a change 
youʼve made, you can return to your 
last unsaved state by clicking on the 
Revert button. This is similar to 
clicking on Undo on another program. 
However, Revert will not work if you 
have saved your changes by clicking 
on the Save, Save As, or Save All 
buttons. These buttons each work 
differently as follows:
• Save: saves only the changes made 

in the currently selected tab and 
button. The previous settings will be 
overwritten with your changes when 
you click on this button.
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• Save As: this button also only saves 
the changes made in the currently 
selected tab and button, but it does 
not overwrite your previous settings. 
When you click on this button, you 
can enter a name for the saved copy 
of your settings.

• Save All: this button saves the 
changes made in every tab and 
button. You should be careful with 
using this option. 

Changing Your Clothing
The Appearance window also has 
tabs for changing the clothes worn by 
your avatar. Changing your avatarʼs 
clothing is done in a similar way as 
changing your body shape and other 
physical features. 

The one difference is that the tabs in 
the Clothes section have Fabric and 
Color/Tint boxes. The Fabric box 
allows you to select a different texture 
from the Inventory. The Color/Tint box 
opens a Color Picker where you can 
choose different colors for your 
clothes. 

There are several ways to change the 
color using the Color Picker:
• Click anywhere in the color ramp on 

the right side of the Color Picker 
window or click on a color square at 
the bottom of the Color Picker.

• enter an RGB value in the text fields 
on the left side of the color picker.

• Click on the eyedropper and sample 
any color in the Second Life window.

Once youʼve chosen a color, click on 
Select to apply it to the currently 
selected clothes.

It is recommended that you make a 
copy of your avatarʼs appearance, 

including the clothes youʼre wearing, 
before you start making changes in 
the Appearance window. This can be 
done by clicking on the Make Outfit 
button at the bottom of the window. 
You should see a popup window 
where you can name your outfit and 
use checkboxes to select which body 
parts and articles of clothing you want 
to include in it. Your avatar will start 
wearing the new saved outfit as soon 
as you click on Save in the Make New 
Outfit window. 

Managing Your Outfits
Each outfit you save is added as a 
folder to your Inventory. To see all of 
your outfits, open the Inventory 
(Command/Control + I) and locate the 
Clothing folder under My Inventory. 

To view the contents of an outfit, click 
on the disclosure triangle to the left of 
its name. The currently worn items will 
have the word “worn” in parenthesis to 
the right of them. 

You can use the Inventory to manage 
your outfits as follows:
• To stop wearing an item, right click 

on it and select Take Off (you can 
right-click and select Wear to put the 
item back on). 

• To delete an item, you must first take 
it off. You can then right-click on it 
and select Delete. 

• To remove an entire outfit, right-click 
on its folder and choose Take Off 
Items. Only do this in a private area 
(your avatar is going to be naked). 

• To put on an entire outfit, right-click 
on its folder and choose Replace 
Outfit, or drag the outfitʼs folder from 
the Inventory to your avatar. 
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Another way to remove clothing, is to 
use the pie menu: right-click on your 
avatar and choose Take Off > Clothes, 
then choose the clothes you want to 
remove. 

Your avatar must always have a 
shape. If you only have one shape in 
your Inventory you will not be able to 
delete it. You will have to create a new 
shape and wear that shape first before 
you can delete the old one.

Attachments
Attachments allow you to add jewelry 
and other items to your avatar. One 
popular use of attachments is adding 
what is known as “sim hair”. This is 
hair that is worn by your avatar just 
like clothes.

To pick up an object you find while 
exploring the virtual world, right-click 
on it to bring up the pie menu and 
choose Buy. You will then see a popup 
showing you how much the item costs 
(it should say Buy for L$0 if the item is 
free). Next, click on Buy and the item 
will be added to your Inventory. 

To attach the object to your avatar, 
locate it in the Objects folder in your 
Inventory, right-click on it, select 
Attach to and choose a body part 
where you want the object to appear. 
To detach the object, right-click on it in 
the Inventory and choose Detach 
From Yourself. You can also detach 
the object using the pie menu: select 
Take Off > Detach and choose the 
body part that has the object attached 
to it. To delete an object from your 
Inventory, right-click on it and choose 
Delete.

Second Life Sites for Educators
• International Spaceflight Museum 

SLurl: http://slurl.com/secondlife/
Spaceport%20Alpha/48/83/24 
(Spaceport Alpha) and http://
slurl.com/secondlife/Spaceport
%20Bravo/12/80/23 (Spaceport 
Beta)

The highlight of this virtual museum is 
the Rocket Ring, where students can 
explore virtual replicas of the most 
famous rockets involved in our 
exploration of space. Although not 
directly affiliated with NASA, this site 
has a lot of information that students 
can use to study the space program.

• National Oceanographic and 
Atmospheric Administration (NOAA) 
Island
SLurl: http://slurl.com/secondlife/
Meteroa/178/160/27/

NOAAʼs website includes several 
simulations related to the weather and 
climate change. Students can view a 
real-time visualization of the US 
weather, ride through a hurricane 
inside a virtual plane, and view a 
simulation of glaciers. 

• Exploratoriumʼs Sploland
SLurl: http://slurl.com/secondlife/
Sploland/185/75/25

This is an interactive science museum 
created by the Exploratorium based in 
San Francisco. One of the most 
popular exhibits on this site is Orbital 
Experience, where you can travel 
around the solar system on Halleyʼs 
Comet. There are also many exhibits 
on optical illusions on this site. 
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• Genome Island
SLurl: http://slurl.com/secondlife/
Genome/180/64/33

This site includes a number of 
simulations and virtual experiments 
related to the study of genetics. On 
this site, students can find a large 
scale replica of an Eukaryotic Cell 
which they can enter and interact with, 
as well as models of DNA.

• Roma
SLurl: http://slurl.com/secondlife/
Roma////

Using the objects and notecards on 
this site, students can learn more 
about the buildings, lifestyle and 
politics of Ancient Rome.

Things to Consider Before Using 
Second Life in the Classroom
• Second Life works best when it runs 

on a computer with good hardware. 
Make sure to check the hardware 
requirements and test it out on your 
lab computers or laptops before 
planning an activity with your 
students.

• The virtual environment can be 
difficult to navigate for students with 
cognitive and other disabilities. Make 
sure you take this into account 
before you design your Second Life 
lessons. You may need to provide an 
alternative if you have students who 
are unable to participate in the 
virtual environment.

• Like the Web, Second Life is an 
open environment where your 
students may easily come across 
inappropriate content. Before you 
start a virtual world activity, you 

should discuss online safety with 
your students and provide them with 
strategies for dealing with 
inappropriate content and behavior 
when they encounter it inworld. You 
can find some tips in the Teen 
Second Life page for parents at 
http://teen.secondlife.com/parents/
safety. Teen Second Life (http://
teen.secondlife.com) may be a great 
place to start exploring Second Life 
with your students if you are 
concerned about online safety in the 
virtual world. 

• Second Life limits the number of 
accounts you can set up from one 
location to prevent abuse of the 
system. To get around this limitation, 
you may want to tell your students to 
set up their accounts at home prior 
to your lesson or activity. 

If youʼre setting up Second Life in a 
computer lab, you may have to 
submit a support ticket to the 
Second Life team before you can 
register multiple accounts from a 
single location. You will need to 
know the IP addresses of the 
computers where you plan to install 
Second Life before you submit your 
ticket. A quick way to find out the IP 
address of any computer is to open 
a web browser on that computer and 
visit the website http://
www.whatismyip.com. 
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